Manual
SmartGraph for Humlog 10

State:
Version:

10.12.2001
V1.0

1

1
1.1

INTRODUCTION TO SMARTGRAPH ................................................................ 4
Manage, Configure .............................................................................................................................. 4

1.2
The Programme Interface................................................................................................................... 4
1.2.1
Graphs .......................................................................................................................................... 5
1.2.2
Table ............................................................................................................................................. 6
1.2.3
Auto Monitor ............................................................................................................................... 7
1.2.4
Monitor for Tables and Graphs ................................................................................................. 8
1.3
Process Measuring Instruments ......................................................................................................... 9
1.3.1
Read Measuring Instrument....................................................................................................... 9
1.3.2
Recorder ....................................................................................................................................... 9
1.3.3
Delete Measurement Data Memory ......................................................................................... 10
1.3.4
Read Configuration ................................................................................................................... 10
1.3.5
Synchronise Clock ..................................................................................................................... 10
1.4

Analyse and Edit................................................................................................................................ 11

1.5

Documentation ................................................................................................................................... 12

1.6

Organisation of Measurement Data on Hard Disk......................................................................... 12

1.7

Upgrade to Extended Functions ....................................................................................................... 13

2

MENU COMMANDS ......................................................................................... 14

2.1
File Menu............................................................................................................................................ 14
2.1.1
Current Unit............................................................................................................................... 14
2.1.2
Print ............................................................................................................................................ 14
2.1.3
Printer Set-up............................................................................................................................. 14
2.1.4
Page set-up ................................................................................................................................. 14
2.1.5
Quit ............................................................................................................................................. 14
2.2
Edit Menu........................................................................................................................................... 15
2.2.1
large time step backwards......................................................................................................... 15
2.2.2
short time step backwards ........................................................................................................ 15
2.2.3
Enlarge........................................................................................................................................ 15
2.2.4
Reduce ........................................................................................................................................ 15
2.2.5
short time step forwards ........................................................................................................... 15
2.2.6
large time step forwards............................................................................................................ 15
2.2.7
Data end...................................................................................................................................... 15
2.2.8
Input date / time range .............................................................................................................. 15
2.2.9
Yt Graph or Table ..................................................................................................................... 16
2.2.9.1
Edit Title................................................................................................................................. 16
2.2.9.2
Merge Out/Merge In Column (for tables only) ................................................................... 16
2.2.9.3
Edit Graph (for graphs only)................................................................................................ 17
2.2.9.4
Value Range Left/Right Y Axis (for graphs only)............................................................... 18
2.2.10
Menu Heading Monitor ............................................................................................................ 18
2.3
View Menu ......................................................................................................................................... 19
2.3.1
Monitor....................................................................................................................................... 19
2.3.2
Yt Graph..................................................................................................................................... 19
2.3.3
Table .......................................................................................................................................... 19
2.3.4
Monitor Menu Headings ........................................................................................................... 19
2.4
Measuring Instruments Menu .......................................................................................................... 20
2.4.1
Communication.......................................................................................................................... 20
2.4.2
Manage Measuring Instruments .............................................................................................. 20
2.4.2.1
Edit Unit ................................................................................................................................. 21
2

2.4.2.2
2.4.3
2.4.4
2.4.5
2.4.6
2.4.7

Edit Channel .......................................................................................................................... 23
Remove Measuring Instrument ................................................................................................ 24
Read Measuring Instrument..................................................................................................... 24
Recorder ..................................................................................................................................... 24
Read Configuration ................................................................................................................... 24
Synchronise Clock ..................................................................................................................... 25

2.5
Options Menu..................................................................................................................................... 25
2.5.1
Protokoll ..................................................................................................................................... 25
3.5.2
Auto Monitor ............................................................................................................................. 26
2.5.4
Upgrade ...................................................................................................................................... 26
2.5.5
Export Function......................................................................................................................... 26
2.5.5.1
Group Channels ..................................................................................................................... 27
2.6
Help Menu.......................................................................................................................................... 27
2.6.1
Additions to the manual ............................................................................................................ 27
2.6.2
Contents...................................................................................................................................... 28
2.6.3
Using Help .................................................................................................................................. 28
2.6.4
Info .............................................................................................................................................. 28

3
3.1

APPENDIX........................................................................................................ 29
Keyboard Operation ......................................................................................................................... 29

3

1 Introduction to SmartGraph
1.1

Manage, Configure

SmartGraph enables the flexible management of several units by means of identifiers. Measuring
instruments can be added at any time. Every measuring instrument can be provided with a description.
The measurement data is automatically archived in Calendar Week files, whereby a sub directory
DlXXX is used for each measuring instrument.
For later access to the stored measurement data it is sufficient to select the measuring instrument
Current Unit using the name in the File Menu.
For security against hard disk errors, completed Calendar Week Files should be regularly saved to
diskette or tape and kept in a safe place.
See also: 2.4.2 Manage Measuring Instruments

1.2

The Programme Interface

The programme interface provides the most comprehensive presentation possible of all the
information, in particular the measurement data.
Measurement data can be viewed via either Graphs or Tables. The programme automatically compiles
graphs and tables for the desired measuring instrument on the interface. Information regarding
selection of the measuring instrument to be presented and the formulation of the interface can be
found under Auto Monitor.
In order to be able to present a greater number of measurement channels the interface is sub-divided
where necessary into pages lying on top of one another. These pages are identified as Monitors.
Switching between different monitors takes place by selecting from a list on the lower frame. The list
disappears if only one monitor is in use.
Different information is presented on the monitors. Correspondingly, there are different monitor types:
- Protocol Monitor: The protocol entries for the preceding time are listed here.
- Monitor for Tables and Graphs
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1.2.1

Graphs

Graphs enable the presentation of measurement values in trace form on a date/time axis. Up to 10
traces with measurement values from different sources, i.e. the selected channels of various units, can
be displayed.
To present measurement values from different units, 2 Y-axes are used (left and right). In this way the
measurement values from two different instruments can be presented on a single graph. Dots in the
colours of the traces alongside the unit of the relevant Y-Axis facilitate the allocation of the trace to the
corresponding Y-Axis.
Navigation within the Date/Time Range
Corresponding control buttons in the tools panel serve to navigate in the Date/Time range (X-axis). It is
possible to move short or long distances in time forwards or backwards, or to enlarge (Zoom) or
reduce (Un-zoom) the screen section along the X-axis. Zoom and Un-zoom can also be obtained by
double-clicking with the mouse in the area of the graphs. In this case the mouse pointer appears as a
magnifying glass. Double-clicking with the left mouse button stretches the time range to the mouse
position, double-clicking with the right mouse button switches from the current time period to the next
largest time range.
Context Menu
For quick and easy changes to Graph contents and settings, a context menu is available. This pops up
when the right mouse button is activated on the graph interface. The same menu headings are
available under the Edit and View menus (under heading Yt-Graph), when the graph is currently
selected (bordered in blue).
The following settings can be specified here:
Edit Title, see 2.2.9.1 Edit Title
Edit Graph, see 2.2.9.3
Edit Graph (for graphs only)
Value Range Left/Right Y-Axis, see 2.2.9.4
Value Range Left/Right Y Axis (for graphs only)
Grid Network Lines to Left/Right Y-Axis
Caption:
If the caption for the currently displayed graphs is not required this can be merged out in order to
provide more space for the graphic.
Print
Print Graph on one page. Can also be obtained via menu heading File-Print-Yt-Graph.
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1.2.2

Table

The Table presents the measurement values of one day. The time is presented in the right column.
The measurement value columns can originate from different units. Measurement values that exceed
the alarm limits are highlighted in bold and in red text.
For space reasons the short description is always used in the unit and channel lines. The long
description is shown in an advice window when the mouse moves over the appropriate cell.
Navigation within the Time Range:
The data from the current day can be obtained via the vertical screen scroll bar. The same function can
be obtained via the Cursor Keys (Arrow up, Arrow down, Page up, Page down) (See also Keyboard
Operation).
Navigation within the Date Range:
Using the control buttons and the user can scroll to the previous or next page, this can also be
carried out via the key combination Ctrl Arrow Up or Ctrl Arrow Down.
The time ranges of the tables and the graphs are synchronised. The day presented in the Table is
always contained in the time range of the Graphs.
Context Menu:
For quick and easy changing of the contents and settings of tables a Context menu is available, which
is activated by pressing the right mouse button. The same menu headings are also available via the
sub menus Tables in the Edit Menu and View Menu, if the table has been selected.
The following operations are possible here:
Edit Title
Merge Out Column
Merge In Column
Horizontal Grid Network Lines
Vertical Grid Network Lines
Print Table:
The Table is printed with the data of the current day. This menu heading can also be obtained via the
in the tools panel and via the menu heading File Print _ Print table.
control button
See also:
3.1 Keyboard Operation
1.2.4 Monitor for Tables and Graphs
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1.2.3

Auto Monitor

The Auto Monitor function enables the automatic build up of one or more monitors with graphs and
table, for the presentation of all channels of one data source or one unit.
Selecting the current unit:
The selection of the current unit that is being presented by the Auto Monitor can take place in two ways
- from the selection list in the tools panel
- from the sub menu under the menu heading File - current unit
The name and identifier of the current unit are displayed in the header of the main window.
Setting up the Auto Monitor:
The automatic building and arrangement of the monitors takes place in accordance with the following
settings. The settings can be amended using the dialog "Auto Monitor Settings", which is available
from the menu heading Options - Auto Monitor.
- De-activate or Switch On Auto Monitor: With the option De-activate no automatic monitors are
provided. This option is only available in the Professional version of the software.
- Maximum number of traces per graph: With this the number of traces that are presented in a single
graph can be limited. Values between 1 and 10 are permissible. If more channels than the maximum
available are present in a data source than can fit into a graph in accordance with your unit, an
additional graph is automatically produced.
- Maximum number of graphs per monitor: The number and units of the channels of a data source
determine how many graphs are necessary for presentation. If more graphs are required than the
maximum number allowed per monitor, additional monitors are automatically produced.
- Use both axes in graphs: When this option is activated, each graph is provided with a left and right Yaxis if necessary, and in this way channels with two different units can be presented. If the option is
deactivated, only the left Y-axis is used.
- Table on separate monitor: When this option is activated, the table appears on a monitor without
graphs. Otherwise graphs and table are arranged together on one monitor.

After the settings have been changed using the dialog, the automatic construction is carried out again
using the current parameters.
If the current unit is changed, the settings that were active at the time of the last presentation of the unit
are used to build the monitor.
On monitors that were produced in this way it is not possible to manually add or remove graphs or
tables. They can only be merged out and the sequence changed. No traces or columns can be
manually added or removed in the graphs and tables. In tables however the Columns can be Merged
Out and the sequence changed. The headers of the monitors are automatically compiled from the unit
name and a serial number and likewise cannot be amended.
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1.2.4

Monitor for Tables and Graphs

The monitor is divided into two halves. On the left side up to 9 graphs are presented, on the right side a
table. The border between the two sides can be shifted freely using the mouse. The graphs are
arranged automatically on the left side in such a way that the space is filled as completely as possible.
The arrangement can take place by choice either alongside or on top of one another (see Monitor Sub
menu in the View menu and Context menu).
Selection:
Whenever a graph or table is selected, i.e. various menu headings or control buttons, such as for
example Print, these all relate to the selected object. The selected item is highlighted by means of a
blue border. An item can be selected by mouse-click or by using the tab key.
Full Screen/Normal Screen:
Each item (graph or table) can be expanded to full screen size. This then fills the entire monitor.
Switching to full screen and back to normal screen size takes place in 4 ways:
on the upper right in the object.
- Activation of the control button or
- Key combination <Ctrl> + and <Ctrl> - Via the Context menu of the monitor
- Via the Monitor Sub menu in the Edit menu.
The menu headings always relate to the selected object.
Merge In/Merge Out:
Each object (table or graph) can be merged out, i.e. it disappears from the screen, but is not lost and
can be merged back in again. The remaining objects are then arranged automatically.
Merge out takes place via :
upper right on the object.
- Control button
- Context menu of the monitor (see below).
- Via the Monitor Sub menu in the Edit menu.
The menu headings always relate to the selected object.
Merge in takes place via the Context menu or the Monitor Sub menu in the Edit menu. The object to be
merged in can be selected via the dialog box that pops up, and the position can also be selected where
the item is to be introduced.
Note: The mechanism can be used to change the Sequence of the Objects on a monitor, where
objects are first merged out and then reintroduced in the desired place.
Context Menu for Monitor:
All operations that concern the monitor can be activated via the Context menu. This appears when the
right mouse button is activated and the mouse is positioned over the index panel of the Monitor or over
a free surface of the monitor. The menu headings also appear in the Monitor Sub menu of the Edit
menu (Full Screen/Normal Screen, Merge In / Out) or in the Monitor Sub menu of the View menu
(Graphs alongside/on top)
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1.3

Process Measuring Instruments

Access to the Measuring Instruments.
1.3.1

Read Measuring Instrument

The memory content of the measuring instrument that is connected to the PC via the serial interface is
read and recorded.
Requirement: The correct interface must be set up.
For set-up use the command Communication in the Measuring Instrument Menu.
Messages:
Whilst reading is taking place the message "Reading Measuring Instrument" is shown with an
indication of the progress of the transmission (percent reading).
If the user has inadvertently selected the interface to which the mouse is connected, SmartGraph
produces the message "Interface already open".
If the message "Measuring Instrument not responding" appears, check whether the correct interface
has been set up and if measuring instrument and PC are connected using the correct cable.
1.3.2 Recorder
With the Recorder function current measurement data from the connected unit is collected, presented
and saved in cyclical manner. In contrast to the command
'Read Measuring Instrument' it is not the measurement value memory of the unit that is accessed here,
but the most recently captured measurement value directly.
During the recording process the connection to the measuring instrument is constant. The settings for
connection type and interface that were defined under Communication are used as the basis for the
connection to the measuring instrument. For the Recorder function, only the connection type PC Direct
is permissible.
The Recorder is started or stopped via the menu heading 'Measuring Instrument - Recorder Start/Stop Recorder' or via the corresponding control buttons in the tools panel. Whilst recording is
taking place a symbol appears in the Status panel.
During the recording operation the following functions are not available:
- Communication
- Read Configuration
- Read Measuring Instrument
- Delete Measuring Instrument Memory
- Synchronise Clock
The measuring instrument clock is automatically synchronised during the recording process.
The following actions lead to recording being broken off:
- Changing a unit or channel setting with "Manage Measuring Instruments"
- "Remove Measuring Instrument"
The time interval for online recording with the Recorder is taken from the memory rate of the unit in
question, this can be set with the command "Manage Measuring Instruments".
The currently measured data can be presented automatically using the function
"Automatic Screen with Data Recording"
This function can be switched on and off from the menu heading in sub menu "Measuring Instrument Recorder" and from the control field in the tools menu.
This enables that during data recording:
- The unit whose data is currently being recorded is presented on the Auto-Monitor.
- The most recently measured data remain within the presentation area of the Graphs or of the Table.
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If necessary the screen will be scrolled to the right or down.
When the function is activated, neither the time range in the traces, the presented day in the table nor
the current unit for the Auto Monitor can be changed manually.

1.3.3 Delete Measurement Data Memory
After activation by the user the memory for the measurement data is deleted in the connected unit.
The settings for connection type and interface that were defined under Communication are used as the
basis for the connection to the measuring instrument.
If no corresponding unit definition has been made then this is done automatically.

1.3.4 Read Configuration
The current configuration of the connected unit is read. The settings for connection type and interface
that were defined under Communication are used as the basis for the connection to the measuring
instrument.
If no corresponding unit definition has yet been set then this is produced automatically. At the request
of the user the current unit (see Auto Monitor) can now be switched over to the connected unit.

1.3.5 Synchronise Clock
The internal clock of the connected unit is synchronised. The settings for connection type and interface
that were defined under Communication are used as the basis for the connection to the measuring
instrument.
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1.4

Analyse and Edit

To analyse the measurement data the presentation range can be selected in steps of 10 seconds to
one year.
To navigate within the time range of the graphics use the Navigator on the upper left under the main
menu. The same functions can be obtained under the menu heading Edit. Zoom and Un-zoom can
also be carried out using mouse click. See also: 3.1 Keyboard Operation
Enlarge, Reduce:
As soon as you move the mouse pointer within the display range of a graphics window it changes into
a magnifying glass.
Enlarge hold the magnifying glass over the required position and click twice with the left mouse
To
button (double click).
The graphic now switches to the next largest size, with the clicked position lying in the centre. (Zoom).
Reduce simply click twice with the right mouse button (Un-zoom).

To

The Presentation Steps are:
Year-Month-Week-Day-6Hours-1Hour-10Minutes-1Minute-10Seconds
Roll:
small time step backwards
To move the graphic section back to the next smallest Time Step

mall time step forwards
To move the graphic section forward to the next largest time step
large time step backwards
To move the graphic section back by an entire Time Step.
large time step forwards
To move the graphic section forward by an entire time step.
Data end
To move the graphic section so that the last data set lies in the presentation range.
Input date / time range
A Dialog Box appears, in which the time range for the presentation can be input. The difference
between start time and stop time must be at least 10 seconds and may be a maximum of one year.
Each operation in a given graphic window will also be carried out in all other graphic windows. The
graphic windows therefore always display the same time section. (When superimposed on top of one
another the results can also be compared very effectively.)
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1.5

Documentation

Printing of tables and graphs:
Printout on the installed Windows printer with full printer resolution.
(See 2.1.2 Print und 2.1.3 Printer Set-up in the File Menu).

1.6 Organisation of Measurement Data on Hard Disk
SmartGraph provides its own sub directory for each measuring instrument dlxxx (xxx =identification) in
the SmartGraph programme directory. Sub directories (dlxxx) are produced for the channels of these
measuring instruments under the associated instrument directories.
The measurement data is saved in Calendar Week files "kwjjnn.sgr". Here jj signifies the year and
nn the number of the calendar week.
When a measuring instrument is deleted the subdirectory DLxxx of the corresponding instrument (xxx
=identification) is renamed DLxxxBAK. The files are not deleted. If a measuring instrument has been
inadvertently deleted, the procedure can be reversed in the following way: Quit SmartGraph and copy
All Files from the directory DlxxxBAK into the directory Dlxxx (e.g. using the File Manager). The next
time SmartGraph is started all the files will then be available.
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1.7 Upgrade to Extended Functions
Functions of the Professional Version
- Instead of the standard measurement units (e.g. temperature in °C and humidity in %RH) the
individual channels of the measuring instrument can be converted to other measurement units (e.g.
temperature in °F or dew point temperature, etc.)
- Export of measurement data to text files.
Release via Key-Code
By acquiring an individual Key-Code the above functions can be easily released.
To do this, select the menu heading Upgrade/Order in the Options Menu. Fill out the fields in the dialog
box "Quotation/Order for Release Code". Select Print to print out an Order form. Fax the order to the
given Fax number and you will shortly receive the Key-Code for the desired release of the appropriate
version.
If you are in agreement with the Licence conditions select the menu heading
Upgrade/Release in the Options Menu. Enter the Key-Code. The additional functions can now be used.
Approval release for the additional functions must be given in accordance with the number of installed
units. If more units are present the additional functions are deactivated.
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2 Menu Commands
2.1

File Menu

The File menu contains the following commands:

2.1.1 Current Unit
Selection of the unit to be presented on the Auto Monitor

2.1.2 Print
Print graphic or table
You may choose whether to print the selected object (graph or table) or a Snapshot (complete visible
monitor).
Tip: When printing, the logo saved in the file LOGO.BMP in the sub directory \Support is printed in the
right upper corner. If you replace this file you can use your own logo. This can be produced using the
programme PaintBrush, for example.
2.1.3 Printer Set-up
Set up options on the installed Windows printer.
Select options for your printer here.
With most printers you have the choice between various graphic resolutions. It is true that a higher
resolution increases quality, however the time required for printing is longer. Try various resolutions to
find the best solution.
Tip: For printing graphs the format "Landscape" is best suited, for printing tables the format "Portrait"
may be better suited, depending on the number of columns.

2.1.4 Page set-up
Set up title and page borders
The dialog box 'Page Set-up' appears with the following input fields:
Title, Sub Title
Fixed page header, that will be printed on every page (e.g. for user data).
Page Borders
Input the desired border in cm here. (The page size must be selected using the command Printer Setup.)
Tip: A logo appears in the top right corner of every printed page. This logo is read from the file
Logo.bmp, which is located in the subdirectory \Support of SmartGraph Index. This file can be replaced
if a different logo is required. If no logo is required the file can be renamed or deleted.

2.1.5 Quit
Quit SmartGraph.
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2.2

Edit Menu

The Edit menu contains the following commands:

2.2.1 large time step backwards
To move the graphic section back by an entire Time Step.
2.2.2 short time step backwards
To move the graphic section back by the next smallest Time Step
2.2.3 Enlarge
The content of the graphic window is enlarged (Zoom)
Enlarge the graphics window to the next time stage, whereby the centre is enlarged.
A double-click with the left mouse button whilst the mouse pointer is within the area of a graphic
window has the same function (mouse pointer =magnifying glass), the only difference is that here the
centre of the enlargement can be defined by the position of the magnifying glass.
Stages are: Year-Month-Week-Day-6Hours-1Hour-10Minutes-1Minute-10Seconds.

2.2.4 Reduce
The content of the graphic window is reduced to the next smallest size (Un-zoom)
Reduce the graphics window to the next time stage.
The identical function is obtained by double-clicking with the right mouse button, where the mouse
pointer becomes a magnifying glass.
Stages are: Year-Month-Week-Day-6Hours-1Hour-10Minutes-1Minute-10Seconds.
2.2.5 short time step forwards
To move the graphic section forward by the next smallest time step

2.2.6 large time step forwards
To move the graphic section forward by an entire time step
2.2.7 Data end
To move the graphic section so that the last data set lies in the presentation area.
2.2.8 Input date / time range
A Dialog Box appears, in which the time range for the presentation can be input.
The difference between start time and stop time must be at least 10 seconds and may be a maximum
of one year.

The other menu headings are relevant to the selected object:
When a monitor is in use, to which these operations are not applicable (e.g. Protocol monitor), these
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menu headings do not appear.

2.2.9

Yt Graph or Table

These menu headings are also available in the context menu, this pops up when the right mouse
button is activated over the surface of a graph.
The following settings can be specified here:
2.2.9.1

Edit Title

Whenever an object is produced (Graph, Table, etc.) a serial number is always provided. The Standard
Title is compiled from the object description and this number.
With the menu heading Edit Title a dialog box appears in which the user can enter a description of his
choice for this object instead of the Standard Title. The title becomes effective when the field Special
Title is marked and the dialog is ended with OK. An empty title is not permitted.
The user can revert to the Standard Title at any time by marking this field and ending the dialog with
OK.
2.2.9.2

Merge Out/Merge In Column (for tables only)

Merge Out Column:
A dialog box appears in which the desired column can be selected. By activating with 'OK' the column
is removed from the table, but not deleted.
Merge In Column:
This menu heading is only available if columns have earlier been merged out. A dialog box appears in
which the measurement unit to be inserted can be selected. With the second selection box the column
can be selected before which the additional column is to be inserted, or the column can be added at
the end.
Note: The mechanism can be used to change the sequence of the columns in a table, whereby
columns are first merged out and then inserted in the desired place.
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2.2.9.3

Edit Graph (for graphs only)

The dialog enables the settings of traces within graphs to be changed.
The available traces are shown in a list on the left side of the dialog. The entry in the list that belongs to
the current trace is highlighted, i.e. selected. If another trace is to be edited this can be selected by
clicking on the corresponding entry.
The parameters that can be set on the selected trace are shown on the right side of the dialog:
- Trace visible: If this setting is activated the trace appears in the graph and in the caption, otherwise
the presentation is suppressed. In so doing the trace is not deleted from the graph but can be made
visible again with all the previous settings.
- Show alarm limits: If this setting is activated the alarm limits of the selected trace appear on the
graph in the colour of this trace. This button is only available when the ‘Trace Visible’ setting is
activated.
- Colour of the trace: By clicking with the left mouse button a list appears with the 16 standard
colours. Colour selection takes place by clicking on the corresponding entry. If a colour different to
the standard colours is desired, clicking with the right mouse button on the selection element starts a
colour selection dialog. The trace and the corresponding caption entry are then shown in the
selected colour.
Control Buttons:
- Transfer: With "Transfer" all changes specified since the start of the dialog, or since the last
"Transfer", are saved. Thereafter, the changes cannot be reversed by activating "Cancel".
- Cancel: The dialog is ended without saving the changes that were specified since the beginning of
the dialog or since the last activation of "Transfer". These changes are thereby lost.
- Close: The changes are saved in the same way as for "Transfer". The dialog is then ended.
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2.2.9.4

Value Range Left/Right Y Axis (for graphs only)

The dialog enables the value range of the Y-axis to be changed within the graphs.
The minimum or maximum of the range can be defined automatically by the programme or manually
by the user.
Automatic Setting:
The automatic setting is selected by activating the relevant upper option field. The corresponding value
is shown alongside on the right. The maximum value of the automatic setting is the highest of all the
values of the presentation ranges of all presented channels (traces). The minimum value corresponds
to the lowest of all the values of the presentation ranges of all the presented channels.
Manual Setting:
The manual setting is effective when the relevant lower option field is activated and the desired value is
registered in the input field alongside.
Control Buttons:
- OK: With "OK" all changes are saved. The dialog is closed.
- Cancel: The dialog is closed without saving the changes.

2.2.10 Menu Heading Monitor
Menu Heading Monitor
This sub menu appears when a Monitor for Graphs and Tables is currently visible.
Object Full Screen
The selected object is enlarged to full screen size
Object Normal Screen
The enlarged object is returned to its normal size
Merge In / Merge Out object
The selected object is merged out, but not deleted. With 'Merge in Object' a dialog box appears with all
the previously merged out objects. An object can be selected here that is to be merged back in again.

When a monitor is in use, to which these operations are not applicable (e.g. Protocol monitor), these
menu headings do not appear.
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2.3

View Menu

The menu heading View contains the appropriate sub menu headings depending on the object
selected:
2.3.1

Monitor

This sub menu appears when a Monitor for Graphs and Tables is actually visible.
To select whether graphs are to be arranged alongside one another or on top of one another
- Arrange graphs alongside one another
- Arrange graphs on top of one another

2.3.2

Yt Graph

Grid Network Lines to the Left Y-Axis:
This menu heading is activated and de-activated by clicking on it. When the menu heading is activated
the grid network lines for scaling the left Y-axis are shown on the graph.
Grid Network Lines to the Right Y-Axis:
This menu heading is activated and de-activated by clicking on it. When the menu heading is activated
the grid network lines for scaling the right Y-axis are shown on the graph.
Caption:
If the caption for the currently displayed graphs is not required this can be merged out in order to
provide more space for the graphic.
These menu headings are also available in the context menu, which pops up when the right mouse
button is activated over the surface of a graph.
This sub menu appears when a Graph is actually selected.
2.3.3

Table

This sub menu is available if Table is currently selected.
Horizontal Grid Network Lines: Merge In / Out
Vertical Grid Network Lines: Merge In / Out
2.3.4

Monitor Menu Headings

With these one can switch between the monitors. The monitor presented is suitably checked

.
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2.4
2.4.1

Measuring Instruments Menu
Communication

A Dialog Box appears for selection of the interface.
Mark the interface to which you wish to connect the measuring instrument and close the dialog box
with 'OK'.
Note:
If you have wrongly selected the interface to which your mouse is connected, SmartGraph produces
the message 'Interface already open' on every attempt to open the interface.
2.4.2

Manage Measuring Instruments

This command opens the dialog box Manage Measuring Instruments

The dialog enables the settings of units, sub modules and channels to be changed.
The available elements that can be modified are presented in a tree diagram in the left part of the
dialog. The tree diagram functions in a similar way to that in Windows Explorer.
The desired element can be selected here by Clicking on the corresponding entry.
By Double-clicking on an entry the associated list of the subordinate entries can be expanded or
merged out.
In this way all elements of the instrument structure are directly selectable and yet complex structures
can also still be presented comprehensively.
The selected entry appears highlighted in colour.
On the right side of the dialog the parameters of the selected element can be worked on.
Information concerning this can be found under
- Edit Unit
- Edit Channel
Control Buttons:
- OK: With "OK" all changes that were made since the beginning of the dialog are saved. The dialog
is ended.
- Cancel: The dialog is ended without the changes being saved. All inputs that were made since the
beginning of the dialog are lost.
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2.4.2.1

Edit Unit

The following parameters of a unit can be changed:
Identifier:
This number identifies a unit uniquely within the SmartGraph software. It defines the lowest level of the
database index in which the unit data is recorded. An identification of 5, for example, belongs to a
subdirectory \DL005.
The identifier can only be changed by adding a new unit within SmartGraph. Later, in particular once
data has already been recorded for this unit, no further change is possible.
Description:
The description of a unit can be freely selected. Within the software the unit is interrogated using this
name and measurement traces, columns in tables etc., are allocated with this name.
Short Description:
The short description can also be freely selected and serves the same purpose as the description. It is
used in places where a long name would for space reasons be unsuitable on the visualisation
interface, e.g. on graph captions or column headings in tables.
The short description should therefore consist of only a few characters. If necessary, abbreviations
should be used.
2.4.2.1.1

Humlog10 Unit Parameters

The setting of parameters takes place on the following indices:
- Information:
The descriptions can be entered here and internal unit information such as revision status can be
read.
- Logging Mode:
The parameters for data capture or recording are set here
Memory organisation: In Start/Stop mode data recording is ended when the memory is full. In ring
mode when the memory is full the oldest data is overwritten
Memory mode: At each memory time the following values can be saved:
Average value of the sampling values across the memory interval
Maximum of the sampling values across the memory interval
Minimum of the sampling values across the memory interval
At least one value must be selected.
Sampling and memory interval: The memory interval must always be greater than or the same as the
sampling interval.
- Pre-selection Operation:
When pre-selection operation is activated the data memory is interrupted and only continues at the
pre-set time. Times in the past are ineffective.
- Display
Either the current status of the unit clock or the memory start time (when pre-selection is activated) is
presented on the unit display. Date and time are shown alternately. The duration of each indication is
input here. Values between 1 and 15 seconds are permitted.
- Sensor Units:
The sensors attached to the two channels are displayed here.
Settings: Using the control buttons the set-up mask for the corresponding channel can be accessed
(see Humlog10 Channel Parameters).
Change Sensor Units: With this control button the measurement units that are captured in the
individual unit channels can be changed. The dialog box Change Sensor Units appears. This setting
possibility is only available when the "Professional" programme version has been supplied for the
available number of units (see Upgrade).
Detailed instructions on the setting possibilities are contained in the unit manual.
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Notes:
- If parameters that are required within the unit itself have been changed, by activating 'OK' connection
is automatically made to the unit in order to transfer the new values. For this purpose the unit must be
connected to the PC and the corresponding serial interface must be set up under "Measuring
Instrument - Communication
- If changes have been made to a unit other than through SmartGraph (e.g. new software version or
different sensor hardware) this change of condition must first be made known to SmartGraph using the
command 'Measuring Instrument _ Read Configuration' , before parameters can be changed.
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2.4.2.2

Edit Channel

The following parameters of a channel can be changed:
Description:
The description of a channel can be freely selected. Up to 79 characters are permissible. Within the
software the channel is interrogated using this name, and measurement traces, columns in tables etc.,
are allocated with this name.
Short Description:
The short description can also be freely selected and serves the same purpose as the description. In
this case a maximum of 20 characters is permissible. It is used in places where a long name would for
space reasons be unsuitable on the visualisation interface, e.g. on graph captions or column headings
in tables.
The short description should therefore consist of only a few characters. If necessary, abbreviations
should be used.
Unit:
This describes the physical unit of the measurement channel or the channel being computed. Up to 20
characters are possible. The unit is defined internally within the software and cannot be changed by the
user.
Measurement Range:
The maximum and minimum of the value range of the measurement channel or calculated channel are
presented here. The values are defined internally within the software and cannot be changed.
Resolution, Decimal Place:
The decimal places are specified here, i.e. the number of places after the decimal separator that will be
used when presenting values in tabular form. Values between 1 and 10 are permitted.
Note: The value can be selected independently of the measurement accuracy or resolution of the
connected unit, however it should relate sensibly to the unit’s specification.
Alarm Limits:
The upper and lower limit values for the alarm presentation can be selected here. These limits, and the
exceeding thereof, are presented in the graph or in tables, if the corresponding option has been set up.
Presentation Range in Graphs:
It can be specified that in graphs the presentation range (Y-range) be automatically defined. The given
maximum and minimum are the basis for the automatic definition. See also the menu heading Value
Range Left/Right Y-Axis in the context menu of graphs.
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2.4.2.2.1

Humlog10 Channel Parameters

Setting of the parameters takes place on the indices:
- Information:
The descriptions and an offset for drift correction can be input here.
- Alarm:
Input the parameters for alarm activation.
On the alarm limits the maximum must be greater than or the same as the minimum.
Alarm limits outside the measuring range of the sensor will be limited to the measuring range.
- Display
see Edit Channel
Detailed instructions on the setting possibilities are contained in the unit manual.
Notes:
- If parameters that are required within the unit itself have been changed, by activating 'OK'
connection is automatically made to the unit in order to transfer the new values. For this purpose
the unit must be connected to the PC and the corresponding serial interface must be set up under
Measuring Instrument Communication
- If changes have been made to a unit other than through SmartGraph (e.g. new software version or
different sensor hardware) this change of condition must first be made known to SmartGraph using
the command Measuring Instrument Read Configuration, before parameters can be changed.
2.4.3 Remove Measuring Instrument
With this command a measuring instrument can be deleted from management by SmartGraph. After
removal the saved data and configuration information are no longer available.
When called up the dialog box 'Remove Measuring Instrument' appears.
Select the desired measuring instrument from the list. On activating 'OK', the selected measuring
instrument is removed, on 'Cancel' no operation is carried out.
Instructions regarding reproduction of the data can be found under Organisation of Measurement Data
on Hard Disk
2.4.4 Read Measuring Instrument
To read measuring instrument memory and save data.
See also: 1.3.1 Read Measuring Instrument
2.4.5 Recorder
With the Recorder function current measurement data from the connected unit are collected,
presented and saved in a cyclical manner.
See also: 1.3.2 Recorder
2.4.6 Read Configuration
To read the current configuration of the connected unit.
See also: 1.3.4 Read Configuration
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2.4.7 Synchronise Clock
The internal clock of the connected unit is synchronised with the PC clock.
See also: 1.3.5 Synchronise Clock

2.5

Options Menu

Commands:
2.5.1 Protokoll
Selection of the protocol options in a dialog box.
This dialog box contains protocol options that can be selected:
Short Protocol
Not all messages are written into the protocol.
Automatic Management of Protocol Files
The size of the protocol file is limited. If the size is exceeded the old file is renamed.
The new file name contains the date of the last entry.
Maximum Length of Protocol File
The maximum length of the protocol file can be selected between 10 Kbytes and 9999 Kbytes. This
setting possibility is only available when the option Automatic Management of the Protocol Files has
been selected.
Protocol only in Auto Mode
Messages are only written to the protocol file in Auto Modus.
When a protocol file is called up, an additional monitor appears automatically, on which the messages
are produced.
Auto Mode is only active when the recorder is running, or when an automatic interrogation is included.
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3.5.2 Auto Monitor
Dialog for editing the Auto Monitor characteristics.
See also: 1.2.3 Auto Monitor
2.5.3 Language
To change the current language. This function can be called up under the language button

2.5.4 Upgrade
Sub menu to order and input a release code.
See also: 1.7

Upgrade to Extended Functions

2.5.5 Export Function
With the Export function, measurement data recorded in the SmartGraph database can be made
available in the form of tables in text files. These text files can be further processed in other
applications (e.g. word processing or spreadsheet calculation).
The function is activated from the menu heading 'Options _ Export' or the corresponding control button
in the tools panel. For Humlog10 the function is only available when the Professional Version
(Upgrade) has been released.
On activation a dialog appears, by means of which all the parameters for export are defined in a series
of several sequential steps. Steps that have already been carried out can be reprocessed at any time
using the control button 'back'.
Step 1: Input Export Time Range
The date and time for start and finish of the exported time range can be input. For this the finish must
be at least 1 second after the start. Activation of the option field 'export without date' has the effect that
the date column is omitted. This option is used when, for example, the data of just one day is exported.
Step 2: Selection of the Channels to be exported
The channels are shown in the list with the name of the unit and the channel. In the table one column
corresponds to each channel.
Selection can be made in two ways:
- Activation of the control button 'Channels of Current Unit' has the effect that Auto Monitor includes all
the channels of the 'Current Unit'.
- On activation of 'Group Channels' the dialog Group Channels appears, by means of which single or
multiple channels from various different units can be selected.
Step 3: Channel information to be exported
In addition to the measurement data, information can be taken for further processing via the exported
channels. When exported into the text file this information is arranged in tabular form over the
measurement data. A line is available for each item of information. The table containing the
measurement data is separated by the word 'Data'.
The following information is available and can be selected by activating the option field in the list.
- Channel number: serial number for the channels in the corresponding column
- Data source: full name of the associated instrument
- Data source short: short name of the associated instrument
- Channel: full name of the channel
- Channel short: short name of the channel
- Sensor type: Identification code for the sensor type (not relevant for Humlog10)
- Unit: Physical measurement unit
- Min: Minimum of the measurement range
- Max: Maximum of the measurement range
- Alarm min: lower alarm limit
- Alarm max: upper alarm limit
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Step 4: File name for the text file
The file name including its path can be input directly or via a File Selection Dialog, which can be called
up via the control button 'Search'. If an existing file is selected, the option 'Add to existing file' has the
effect that the measurement data are added. In this case, channel information (Step 3) is not exported.
If the option is not activated if necessary an existing file will be overwritten. If an unavailable file name
is selected then this option field does not apply.
Step 5: Format settings for text output.
The following settings can be specified:
- Date format: Date separator, Sequence, Year in 2 or 4 characters
- Time: Separator
- Decimal setting (. or ,) for measurement values
- Separator between columns (e.g. channels). May not be the same as the separator for date and time.
- Character for line end (e.g. separation of data sets)
- Character string to be entered for erroneous or invalid measurement values
e.g. "---" or "MISSING". The character string must not contain the column separator. An empty
character string is permitted.
The export is executed using the control button 'Ready'.

2.5.5.1

Group Channels

The dialog enables the selection and grouping of several channels from any data source. The selected
channels are then presented, for example, in a table.
The available data sources (units) are presented in a list on the left hand side of the dialog. The
required data source can be selected here by clicking on the corresponding entry. The selected entry
then appears highlighted in colour.
All the channels of the chosen data source, that can be selected, are presented in the middle list.
The transferred channels are shown in the right hand list with their respective data sources. Activating
'OK' enables these channels to be processed further.
In
Channels in the middle list can be transferred to the right hand list via the control button and
order to do this one or more channels must first be selected in the middle list. To select multiple entries
use the left mouse button together with the 'Shift' and 'Control' keys. To select all entries use the
control button 'Select All'.
The sequence of the transferred entries in the right hand list can be changed via the control buttons
In this way, for example, the sequence of columns in a table is changed. To do this the
and
required entry must first be clicked on.
An entry that appears in the right hand list by mistake can be removed using the control button

.

With 'OK' the chosen channels with their selected data sources in the right hand list are accepted for
further processing. The dialog is ended.
Cancel: The dialog is ended without transferring the selection. The procedure is halted.

2.6

Help Menu

Commands for the Windows Online Help:
2.6.1

Additions to the manual
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The most recent changes and additions that have arisen after the printing of the manual.
2.6.2 Contents
Starts the Online Help and shows the contents index of the Help topics.
2.6.3 Using Help
Introduction to the Windows Help system.
2.6.4 Info
Version number and Copyright of the current software version.
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3 Appendix
3.1

Keyboard Operation

All Scroll and Zoom functions can also be easily operated using the keyboard. According to which unit
is already active (the desired object can be also be selected with the keyboard by TAB), the following
key functions are defined:
Graphic, Table and Report Windows
Ctrl+
Object Full Screen
CtrlReverse Object Full Screen
TAB
Change to Next Object
Graphic Window
+
->
<Ctrl ->
Ctrl <End

Enlarge Graphic (Zoom)
Reduce Graphic (Un-zoom)
Scroll Right
Scroll Left
Page Right
Page Left
Data End

Tables and Report Windows
Arrow Up
Arrow Down
Page Up
Page Down
Ctrl + Arrow Up
Ctrl + Arrow Down
<->
Ctrl ->
Ctrl <Pos1
End

Scroll Up
Scroll Down
Large Step Back
Large Step Forwards
Scroll Back by 1 Day/Month/Year
Scroll Forward by 1 Day/Month/Year
Scroll Left
Scroll Right
Large Step to Right
Large Step to Left
Go To Beginning of Table
Go To End of Table
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